Неприступная крепость в Фотошоп

В этом уроке вы узнаете, как создать таинственное изображение крепости  на фоне шторма. Кроме этого, вы узнаете, как совмещать стоковые изображения и создавать задний фон в шторм и как применять световые эффекты.

Итоговый результат

Исходные материалы:
Задний фон
Поле
Пустыня
Окаменевший лес Национальный Парк
Крепость
ШАГ 1  Создайте Новый Документ
Давайте создадим новый документ, идём Меню – Файл – Новый (Menu >File > New), и применяем следующие настройки в соответствующих полях:
Набор (Presets): Заказной (Custom)
Ширина (Width): 3000 px
Высота (Height): 3000 px
Разрешение (Resolution): 300 pх/дюйм
Цветовой режим (Color Mode): RGB Color; 8 bit
Содержимое фона (Background Contents): Прозрачный (Transparent)
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ШАГ 2 - Создайте Небо
В этом шаге мы создадим небо для нашего изображения. Для начала, откройте стоковое изображение “Задний фон”. Как только открылось изображение, выберите инструмент Прямоугольная область [image: image2.png]


(Rectangular Marquee tool (M) и выделите часть неба. См. скриншот ниже:
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Теперь, когда вы создали выделение вокруг неба, выберите инструмент Перемещение [image: image5.png]


(Move tool (V) и переместите выделенное изображение с небом на наш документ.

Расположите изображение с небом, как на скриншоте ниже:
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Далее, дважды щёлкните по окошку с текстом “Слой 1” и переименуйте этот слой в “Небо 1”.
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Сейчас, мы масштабируем изображение, чтобы оно стало частью неба в нашей сцене; для этого, выберите инструмент Трансформация (Transform tool (Ctrl + T).
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Результат должен быть, как на скриншоте:
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Мы создали первую часть неба, сейчас мы сделаем небо более эффектным и драматичным. Для этого, мы добавим часть неба со стокового изображения “Поле”. Откройте упомянутое изображение, как только оно открылось, создайте выделение с помощью инструмента Прямоугольная область [image: image10.png]


(Rectangular Marquee Tool (M). См. скриншот ниже:
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После этого, выберите инструмент Перемещение [image: image12.png]


(Move tool (V) и переместите выделенное изображение неба на наш документ. Убедитесь, чтобы он был расположен поверх слоя “небо 1”; для этого, просто щёлкните по слою и перетащите его поверх слоя “небо 1”.

Переименуйте новый слой с небом в “небо 2”. Далее, расположите “небо 2”, как показано на скриншоте ниже:
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Далее, выберите инструмент Трансформация (Transform tool (Ctrl + T) и масштабируйте “небо 2”, как показано на скриншоте ниже:
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Результат:
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Для того, чтобы совместить эти два изображения с небом, нам понадобиться продублировать слой “небо 2”, нажав клавиши Ctrl+ J, а затем поменять режим наложения дубликата “небо 2” на Умножение (Multiply). Для этого, просто следуйте инструкциям на скриншотах ниже:
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Выберите режим наложения Умножение (Multiply), как только появится контекстное меню:
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Итак, изображение в результате изменения режима наложения выглядит следующим образом:
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Шаг 3 - Создайте Землю 
В этом шаге мы создадим землю, на которой будет построена крепость. Вначале, давайте, откроем стоковое изображение “Пустыня”. Выберите инструмент Прямоугольная область [image: image19.png]


(Rectangular Marquee Tool (M) и создайте выделение части пустыни, как показано на скриншоте ниже:
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Далее, выберите инструмент перемещение и переместите выделенное изображение на наш документ. Расположите слой с пустыней поверх слоёв “небо 1” и “небо 2”. Расположите, как показано на скриншоте ниже:
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Переименуйте этот слой в “земля 1”. Далее, нам необходимо масштабировать изображение. Выберите инструмент трансформацию и примените масштабирование, как показано на скриншоте ниже:
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Результат должен быть, как на скриншоте:
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Для соответствия освещения земли с небом, нам нужно уменьшить Яркость / Контрастность (Brightness/Contrast). Для этого, убедитесь, чтобы слой “земля 1” был активным, далее идём Изображение – Коррекция – Яркость / Контрастность (Image > Adjustments > Brightness/Contrast) и применяем следующие значения:
Яркость (Brightness): -70
Контрастность (Contrast): 0
Использовать прежние (Use Legacy): Галочку не ставить (Uncheck)
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Результат должен быть, как на скриншоте:
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Далее, нам нужно немного затемнить землю перед тем, как мы установим крепостную стену, чтобы упростить работу по световой коррекции.

Для этого, убедитесь, чтобы слой “земля 1” был активным, затем создайте новый слой Ctrl+ Shift + N. Данное действие необходимо, чтобы новый слой автоматически был создан поверх активного слоя. Итак, когда появится диалоговое окно при создании нового слоя, назовите это слой "затемнение". См. скриншот ниже:
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Далее, щёлкните правой кнопкой мыши по слою “затемнение” и выберите опцию Создать обтравочную маску (Create Clipping Mask), таким образом, действие кисти будет применено только к слою "земля 1".
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Итак, как только вы создали новый слой, выберите инструмент Кисть [image: image28.png]


(Brush tool (B), но переде тем, как мы приступим, убедитесь, чтобы кисти были установлены по умолчанию. Стандартные кисти Photoshop по умолчанию показаны на скриншоте ниже, если у вас установлены другие кисти, то следуйте инструкции на скриншоте ниже:
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Щёлкните правой кнопкой мыши по документу, слой и кисть при этом должны быть активными, а затем нажмите значок, который выделен жёлтым цветом:
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Когда появится контекстное меню, выберите опцию Восстановить кисти (Reset Brushes).
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Теперь, когда вы восстановили кисти, примените следующие значения для кисти:
Размер кисти (Brush size): 1100px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет (Color) #: 000000
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Примечание #: 000000 означает номер цветового оттенка кисти. Для того, чтобы поменять цветовой оттенок кисти, просто следуйте инструкции на скриншоте ниже:
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Как только откроется окно Палитры цветов(Color Picker), примените следующий цветовой оттенок # 000000:
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Итак, давайте, затемним участки, которые необходимо было затемнить:
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Результат должен быть, как на скриншоте:
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Далее, мы осветлим горизонт неба; для этого, ещё раз создайте новый слой Ctrl + Shift+ N и назовите его “горизонт”. Убедитесь, чтобы этот слой был расположен поверх слоя “затемнение”.

Как только вы создали новый слой, выберите кисть и примените следующие значения:
Размер кисти (Brush size): 800px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет (Color) #: ffffff
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Итак, мы можем прокрасить горизонт.
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В результате мы должны получить светлый горизонт, как показано на скриншоте ниже:
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Далее, пришло время добавить второе стоковое изображение, это будет скальный грунт в нашей заброшенной пустыне. Для начала, откройте стоковое изображение “Окаменевший лес. Национальный парк”.

Как только открылось стоковое изображение, выберите инструмент Прямолинейное лассо[image: image40.png]


(Polygonal Lasso Tool (L),  т.к. с помощью данного инструмента мы создадим выделение скального участка на изображении.
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Давайте выделим скальный грунт!
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Как только вы создали выделение, выберите инструмент Перемещение [image: image43.png]


(Move tool (V) и переместите выделенную область на наш документ. Расположите этот слой поверх всех слоёв, которые мы создали.

Расположите, как показано на скриншоте ниже:
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Переименуйте этот слой в “земля 2”. Далее, выберите инструмент Трансформация (Transform tool (Ctrl + T) и масштабируйте изображение, как показано на скриншотах ниже:
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Результат трансформации должен быть, как на скриншоте ниже:
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Теперь, давайте, уменьшим Яркость / Контрастность (Brightness/Contrast) этих камней для их совмещения с “земля 1”. Идём Изображение – Коррекция – Яркость / Контрастность (Image > Adjustments > Brightness/Contrast) и применяем следующие настройки:
Яркость (Brightness): -70
Контрастность (Contrast): 0
Использовать прежние (Use Legacy): Галочку не ставить (Uncheck)
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Результат должен быть, как на скриншоте:
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Для создания более плавного перехода слоя “земля 2”, нам необходимо применить ластик и обработать некоторые участки ластиком, поэтому выберите инструмент Ластик [image: image51.png]


(Eraser tool (E) и примените следующие значения:
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Размер кисти (Brush size): 150 px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 100%
Нажим (Flow): 100%

Как только вы настроили ластик, примените его в указанной области, как на скринщоте ниже:
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Результат должен быть, как на скриншоте:
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Ещё раз, вот так выглядит изображение без применения ластика:

[image: image56.jpg]



Сейчас, давайте затемним основную часть земли, чтобы не было видно перехода между слоями “земля 1” и “земля 2” с остальным изображением; поэтому, создайте новый слой Ctrl + Shift + N, назовите этот слой “затемняем землю”. Убедитесь, чтобы этот слой был расположен поверх всех слоёв, которые мы создали.

Выберите кисть и примените следующие значения:
Размер кисти (Brush size): 1300px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет (Color) #: 000000

Давайте, применим кисть!
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Результат должен быть, как на скриншоте:
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Итак, задний фон завершён, поэтому, выделите все слои, которые мы создали, а затем нажмите Ctrl + G, чтобы сгруппировать эти слои. Как только вы создали новую группу, назовите эту группу “BG”.

Примечание переводчика: BG (Background ) - Задний фон (ЗФ).
Примечание: Переименовать группу можно также, как и переименовать слой.

Шаг 4 - Крепость
Сейчас, мы добавим огромную крепостную стену, откуда будет исходит мистический свет. Для начала, давайте, откроем стоковое изображение “Крепость”.

Как только открылось изображение, выберите инструмент Прямолинейное лассо (Polygonal Lasso Tool (L) и создайте выделение вокруг крепостной стены. См. скриншот ниже:
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Далее, выберите инструмент перемещение и переместите выделенное изображение на наш документ. Расположите этот слой поверх группы “BG”, которую мы создали.

Расположите изображение крепостной стены, как показано на скриншоте ниже:
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Переименуйте этот слой в “крепостную стену”. Далее, выберите инструмент  трансформация (Ctrl + T) и примените масштабирование, как показано на скриншоте ниже:
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Результат должен быть, как на скриншоте:
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Далее, мы совместим крепостную стену с “земля 1”. Для этого, нам понадобится инструмент Ластик [image: image64.png]


(Eraser tool (E). Выберите инструмент и примените следующие значения для ластика:
Размер кисти (Brush size): 100px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 100%
Нажим (Flow): 100%

Итак, давайте, применим ластик.
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Результат должен быть, как на скриншоте:
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Более детально:
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Сейчас, мы усилим свет на “крепостной стене”, давайте сделаем её немного темнее. Создайте новый слой (Ctrl + Shift + N), назовите этот слой “затемняем стену”. Убедитесь, чтобы это слой был расположен поверх слоя “крепостная стена”. Щёлкните правой кнопкой по этому слою и как только появится контекстное меню, выберите опцию Создать обтравочную маску (Create Clipping Mask).

Активируйте кисть и далее примените следующие настройки:
Размер кисти (Brush size): 1100px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет (Color) #: 000000
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Результат должен быть, как на скриншоте:
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Шаг 5   Создайте Загадочный Свет
Сейчас, мы добавим загадочный свет, который исходит из крепостных ворот. Давайте начнём с создания нового слоя (Ctrl + Shift + N), назовите этот слой “Свет”. Убедитесь, чтобы этот слой был расположен поверх слоя “затемняем стену”. Выберите инструмент кисть и примените следующие настройки:
Размер кисти (Brush size): 1400px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 25%
Нажим (Flow): 100%
Цвет (Color) #: ffffff

Кисть настроена, давайте создадим лёгкое свечение:

[image: image71.jpg]



Результат:
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Далее, давайте создадим свет, исходящий из крепостных ворот. Начнём с создания нового слоя (Ctrl + Shift + N), расположите его поверх слоя “свет”; назовите этот слой “свет изнутри 1”.
Выберите кисть и примените следующие настройки для кисти:
Размер кисти (Brush size): 50px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 100%
Нажим (Flow): 100%
Цвет (Color) #: fffed8
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Итак, давайте, применим кисть:
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Результат должен быть, как на скриншоте:
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Далее, создайте ещё один новый слой (Ctrl + Shift + N), назовите его “свет изнутри 2”. Расположите этот слой поверх слоя “свет изнутри 1”. Выберите инструмент кисть и примените следующие настройки:
Размер кисти (Brush size): 175px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 50%
Нажим (Flow): 100%
Цвет (Color) #: fffed8

Итак, давайте, применим кисть:
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Результат должен быть, как на скриншоте:

[image: image77.jpg]



Далее, ещё раз создайте новый слой (Ctrl + Shift + N), назовите его “свет изнутри 3”. Ещё раз выберите инструмент кисть и примените следующие настройки для кисти:
Размер кисти (Brush size): 80px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 25%
Нажим (Flow): 100%
Цвет (Color) #: fffed8
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Результат:
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Далее, давайте создадим ещё один слой (Ctrl + Shift + N), назовите этот слой “свет изнутри 4”. Выберите кисть и примените следующие значения для кисти:
Размер кисти (Brush size): 80px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 25%
Нажим (Flow): 100%
Цвет (Color) #: fffed8

Итак, давайте, применим кисть:
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Результат должен быть, как на скриншоте:
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В заключении создайте последний слой (Ctrl + Shift +N), назовите этот слой “свет изнутри 5”. Выберите кисть и примените следующие настройки для кисти:
Размер кисти (Brush size): 80px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 25%
Нажим (Flow): 100%
Цвет (Color) #: ffffff

Итак, давайте, применим кисть:

[image: image82.jpg]



Результат:
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Итак, давайте затемним всю крепость и землю. Для этого, создайте новый слой (Ctrl + Shift + N) поверх всех слоёв и групп, назовите этот слой “Затемненное изображение”. Как только вы создали новый слой, выберите кисть и примените следующие настройки:
Размер кисти (Brush size): 1600px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет (Color) #: 000000

Итак, давайте, применим кисть, как показано на скриншоте ниже:
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Результат:
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Теперь, когда мы закончили создавать загадочный свет, выделите все слои, которые вы создали в Шаге 4 – Шаге 5 и сгруппируйте их (Ctrl + G). Назовите эту группу “СТЕНА”.

Шаг 6 - Создайте Виньетку
В этом шаге, вы узнаете, как создать эффект виньетки с помощью усиления фокуса на объекте. Для начала, идём в меню и нажимаем Файл - Новый (File > New) и применяем те же самые настройки, которые мы использовали при создании нашего документа (Ссылка на Шаг 1). Обратите внимание, что содержимое фона должен быть- белый. Как только вы создали новый документ, идём Фильтр – Искажение – Коррекции дисторсии (Filter > Distort > Lens Correction). В настройках Виньетки, примените следующие значения:
Виньетка (Vignette)
Эффект (Amount): -100
Средняя точка (Midpoint): +50
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Теперь, когда мы создали виньетку, переместите виньетку на наш документ с помощью инструмента перемещения и расположите слой с виньеткой поверх всех слоёв, которые мы создали, а затем поменяйте режим наложения и непрозрачность слоя с виньеткой:
Режим наложения (Blending mode): Умножение (Multiply)
Непрозрачность (Opacity): 40%

Примечание: режим наложения можно поменять в верхней панели в палитре слоёв. Окно непрозрачности слоя расположено рядом. См. скриншот ниже:
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При Нормальном (Normal) режиме наложения, виньетка будет выглядеть таким образом:
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После того, как вы поменяете режим наложения на Умножение (Multiply), изображение будет выглядеть, как на скриншоте ниже:
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Шаг 7 - Усиливаем Цвета Изображения и Контраст
Сейчас, давайте, усилим контраст и цветовые оттенки изображения, а также проведём световую коррекцию. Для начала, давайте, создадим новый корректирующий слой Цвет (Solid Color), для этого нажмите кнопку в нижней панели инструментов Создать новый корректирующий слой или слой- заливку (Create New Fill/Adjustment layer).
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Как только появится контекстное меню, выберите опцию Цвет (Solid Color):
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Как только вы выбрали опцию Цвет (Solid Color), появится окно Палитра цветов (Color Picker). Итак, примените следующий цветовой оттенок:
Цвет (Color) #: 000218
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Сейчас, ваше изображение залито тёмно-синим оттенком. Чтобы исправить это, нам нужно поменять режим наложения и непрозрачность корректирующего слоя на следующие значения:
Режим наложения (Blending mode): Исключение (Exclusion)
Непрозрачность (Opacity): 40%
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Далее, создайте ещё  один корректирующий слой Цвет (Solid Color), для этого нажмите кнопку в нижней панели инструментов Создать новый корректирующий слой или слой- заливку (Create New Fill/Adjustment layer). На это раз примените следующий цветовой оттенок:
Цвет (Color) #: edbb36
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Как только вы закончили, поменяйте режим наложения, непрозрачность и заливку на следующие значения:
Режим наложения (Blending mode): Мягкий свет (Soft Light)
Непрозрачность (Opacity): 20%
Заливка (Fill): 40%
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Сейчас, давайте создадим корректирующий слой Карта градиента (Gradient Map),  для этого нажмите кнопку в нижней панели инструментов Создать новый корректирующий слой или слой- заливку (Create New Fill/Adjustment layer).
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Сейчас, когда появится окно настроек Карты градиента, следуйте инструкции на скриншоте ниже:
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Вы заметите, что ваше изображение стало Чёрно- белым, поэтому, поменяйте режим наложения и непрозрачность слоя на следующие значения:

Режим наложения (Blending mode): Свечение (Luminosity)
Непрозрачность (Opacity): 60%
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Далее, давайте усилим Цветовой тон/ Насыщенность (Hue/Saturation) всего изображения.

[image: image100.jpg]Levels...
Curves...

Color Balance...
Brightness/Contrast...

Selective Color...

Channel Mier...
Gradient Map...
Photo Filter...

Exposure...
Invert
Threshold.

Posterize.





Как только появится окно настроек, примените следующие значения:
Редактировать (Edit): Все (Master)
Цветовой тон (Hue): 0
Насыщенность (Saturation): 15
Яркость (Lightness): 0
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В заключении, давайте усилим Яркость / Контрастность (Brightness/Contrast), для этого создайте новый корректирующий слой через нижнюю панель инструментов Создать новый корректирующий слой или слой- заливку (Create New Fill/Adjustment layer).
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Когда появится окно настроек, примените следующие значения:
Яркость (Brightness): -5
Контрастность (Contrast): 20
Использовать прежние (Use Legacy): Галочку не ставить (Uncheck)
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Итоговый результат должен быть, как на скриншоте:
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Итоговый результат
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